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Installation Check List
Single

Classroom
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Task Reference

Ensure your computers and network meet the
SMART Sync™minimum requirements.

page 41

Select a type of installation:
l Single classroom

l School or district wide

page 3

Install SMART Sync Class List Server. page 14

Install SMART Sync Administrator Tool. page 16

(Optional) Export information from third-party
applications to CSV files.

page 17

Create a SMART School (.school) file. page 20

Install SMART Sync Teacher on teachers’
computers and SMART Sync Student on
students’ computers.

page 6
OR
page 28

(Optional) Configure SMART Sync Student. page 9
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Getting Started
Computer and Network Requirements 1

Teacher and System Administrator Computers 2
Student Computers 2
Network 2

Selecting a Type of Installation 3
Single Classroom Installation 3
School- or District-Wide Installation 4

This guide explains how to install and configure SMART Sync classroommanagement
software.

This guide is intended for IT administrators and others experienced with installing,
configuring and administeringWindows® software in a networked environment. To use
this guide, youmust:

l Know IT terminology such as “registry” and “domain controller”

l Know how to complete basic administrative tasks inWindows operating systems
such as opening the Control Panel or modifying the registry

l Have administrative privileges and access to your school’s servers

l Have the SMART Sync CD or access to the SMART Support website

Computer and Network Requirements
Before installing SMART Sync, ensure your computers meet theminimum requirements
defined in this section.

NOTE

In addition, review the recommended settings for your computers and networks
on page 41.
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Teacher and System Administrator Computers
l Pentium® III 600MHz processor

l 256MB of RAM

l 100MB of free hard disk space

l Windows XP, Windows Vista® orWindows 7 operating system

l 800 × 600 or higher resolution display with 16-bit color quality

l Internet Explorer® Internet browser version 5.0 or later

l DirectX® technology version 7.0a or later

Student Computers
l Pentium III 500MHz processor

l 128MB of RAM

l 55MB of free hard disk space

l Windows XP, Windows Vista orWindows 7 operating system

l 600 × 480 or higher resolution display with 16-bit color quality

l Internet Explorer Internet browser version 5.0 or later

l DirectX technology version 7.0a or later

Network
l 802.11 a/g wireless network (minimum)

100Mbps wired network or 802.11 n wireless network (recommended)
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Selecting a Type of Installation
SMART Sync consists of four components.

Component Purpose Typical Location
SMART Sync Teacher Allows teacher to connect with

students and other teachers
Teachers’ computers

SMART Sync Student Allows students to connect with
teachers

Students’ computers

SMART Sync Class List
Server

Connects teachers’ and students’
computers

Server accessible to all
teachers’ and students’
computers

SMART Sync
Administrator Tool

Allows teachers and system
administrators to create and edit
SMART School files, which are
central repositories of student,
teacher, class, computer lab and
computer information, and
application and Internet blocking
rules

Teachers’ or system
administrators’
computers

Which of these components you install depends on whether you’re implementing
SMART Sync in a single classroom or across your school or district.

Single Classroom Installation
A single classroom installation includes SMART Sync Teacher and SMART Sync
Student:

l The teacher creates his or her own teacher ID, classes, application blocking rules
and Internet blocking rules andmanages the class with SMART Sync Teacher.

l Students connect to the teacher through SMART Sync Student by selecting the
teacher’s ID from a drop-down list or entering the teacher computer’s host name or
IP address.

See Installing SMART Sync in a Single Classroom on page 5 for instructions on
completing this type of installation.
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NOTE

Although this type of installation is preferable if you’re installing SMART Sync in
a single classroom, complete the procedures for a school- or district-wide
installation if you’re considering installing SMART Sync in other classrooms in
the future.

School- or District-Wide Installation
A school- or district-wide installation includes all four components.

Teachers and students connect to each other thorough SMART Sync Class List Server.

Unlike in single classroom installations, in school- or district-wide installations, teacher
IDs, classes, application blocking rules and Internet blocking rules are centrally
managed in SMART School files created with SMART Sync Administrator Tool. This
makes this type of installation ideal for implementing SMART Sync across your school
or district.

See Installing SMART Sync Across a School or District on page 13 for instructions on
completing this type of installation.
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Installing SMART Sync in a
Single Classroom
Installing SMART Sync Teacher and SMART Sync Student 6

Installing SMART Sync Teacher 6
Installing SMART Sync Student 7
Deploying the SMART Sync Teacher and SMART Sync Student Installation
Packages

7

Connecting Students to Teachers 8
Configuring SMART Sync Student 9

Running the SMART Sync Student Configuration Tool 9
Automatically Configuring SMART Sync Student 12

In a typical single classroom installation, you install SMART Sync Teacher on one or
more teachers’ computers and SMART Sync Student on students’ computers:

After installation, the teacher creates his or her own class, and application and Internet
blocking rules. The students connect to the teacher by selecting the teacher’s ID from a
drop-down list or entering the teacher computer’s host name or IP address. However,
you can change this if necessary by configuring SMART Sync Student.
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Installing SMART Sync Teacher and
SMART Sync Student
If you’re installing SMART Sync Teacher and SMART Sync Student on a small number
of computers or if teachers and students are responsible for installing software on their
own computers, use the installation wizards to install the software.

You can start the installation wizards by inserting the SMART Sync CD into the
computer or downloading executable (.exe) files from the SMART website.

Installing SMARTSync Teacher

To install SMART Sync
Teacher from the CD 1. Insert the SMART Sync CD in the computer.

TheSMART Sync ClassroomManagement Software dialog box appears.

NOTE

If the dialog box doesn’t appear, browse to and open
[CD Drive]\CDBrowser.exe.

2. Click Install Teacher Edition.

The SMART Sync Teacher installation wizard appears.

3. Follow the on-screen instructions.

4. Click Install.

Windows Installer installs SMART Sync Teacher.

To install SMART Sync
Teacher from the website

1. Go to www.smarttech.com/downloads.

2. Browse to the SMART Sync 2010 download page, and then follow the on-screen
instructions to download the SMART Sync Teacher executable file.

3. Double-click the executable file.

The SMART Sync Teacher installation wizard appears.

4. Follow the on-screen instructions.

5. Click Install.

Windows Installer installs SMART Sync Teacher.
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Installing SMARTSync Student

To install SMART Sync
Student from the CD 1. Insert the SMART Sync CD in the computer.

TheSMART Sync ClassroomManagement Software dialog box appears.

NOTE

If the dialog box doesn’t appear, browse to and open
[CD Drive]\CDBrowser.exe.

2. Click Install Student Edition.

The SMART Sync Student installation wizard appears.

3. Follow the on-screen instructions.

4. Click Install.

Windows Installer installs SMART Sync Student.

To install SMART Sync
Student from the website

1. Go to www.smarttech.com/downloads.

2. Browse to the SMART Sync 2010 download page, and then follow the on-screen
instructions to download the SMART Sync Student executable file.

3. Double-click the executable file.

The SMART Sync Student installation wizard appears.

4. Follow the on-screen instructions.

5. Click Install.

Windows Installer installs SMART Sync Student.

Deploying the SMARTSync Teacher and SMARTSync Student
Installation Packages
If you’re installing SMART Sync Teacher and SMART Sync Student on a large number
of computers, you can deploy the installation packages to the teacher’s and students’
computers as documented in Installing SMART Sync Teacher and SMART Sync
Student on page 28.
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Connecting Students to Teachers
After you install SMART Sync Teacher on the teacher’s computer and SMART Sync
Student on the students’ computers, students can connect to the teacher’s computer
through the software.

By default, SMART Sync Student starts in visible mode when a student first logs on to
his or her computer. The student then enters his or her own ID and connects to the
teacher’s computer by doing one of the following:

l Selecting the teacher’s ID from a drop-down list of teachers currently logged on to
SMART Sync Teacher if multicasting is enabled on your school’s network

l Entering the host name or IP address of the teacher’s computer if multicasting
isn’t enabled on your school’s network

T I PS

l If multicasting isn’t enabled on your school’s network and you want to
allow students to selecting the teacher’s ID from a drop-down list, install
SMART Sync Class List Server (see page 14) and connect SMART Sync
Teacher and SMART Sync Student to it (see the Help).

l Teachers can determine the IP address of their computers by selecting
Help > About SMART Sync in SMART Sync Teacher.

In some classrooms, students always connect to the same teacher or teacher computer.
For these situations, you can configure SMART Sync Student to connect to a specified
teacher ID, host name or IP address rather than requiring the student to provide this
information each time he or she logs on.

For more information, see the following section.
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Configuring SMART Sync Student
Run the SMART Sync Student Configuration Tool to configure SMART Sync Student
on a student’s computer. The SMART Sync Student Configuration Tool updates the
SyncClient.ini file on the student’s computer, which you can then use to configure
SMART Sync Student on other students’ computers without running the tool each time.

Running the SMARTSync Student Configuration Tool
If you want to configure a SMART Sync Student installation, you can run the SMART
Sync Student Configuration Tool.

To run the SMART Sync
Student Configuration

Tool

1. Select Start > All Programs > SMART Technologies > SMART Sync >
SMART Sync Student Configuration Tool 2010.

TheSMART Sync Student Configuration Tool dialog box appears.

2. Click Next.

3. In the Interface page, select one of the following options, and then click Next.

Option Select this option to:
Visible to students Show the SMART Sync Student user interface to

the student.
Hidden from students Hide the SMART Sync Student user interface from

the student.

NOTE

If you click Hidden from students, the student won’t be able to do the
following:

o Connect to a teacher by selecting the teacher’s name from a list

o Manually start SMART Sync Student

o Manually enter an ID after starting SMART Sync Student

The relevant controls in SMART Sync Student Configuration Tool will be
disabled or hidden.
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4. In theStartup page, select one of the following options:

Option Select this option to:
Allows the student to
select from a list of
available teachers

Allow the student to select a teacher from a drop-
down list using teacher discovery.

NOTE

This option is disabled if you clicked
Hidden from student in step 3.

Automatically connects
with this Teacher ID

Connect SMART Sync Student to a specific
teacher through the teacher’s ID.
Type the ID in the box below the option.

Automatically connects
with this hostname or IP
address

Connect SMART Sync Student to a specific
teacher through the host name or IP address.
Type the host name or IP address in the box below
the option.

NOTE

If your network uses DHCP, refer to the
computer by host name rather than by IP
address.

Automatically connects
using administered
classes

Connect SMART Sync Student to a specific
teacher specified in a SMART School file.

5. If you selectedAllows the student to select from a list of available teachers
and want to use SMART Sync Class List Server for teacher discovery or if you
selectedAutomatically connects using administered classes, select the
Uses this Class List Server hostname or IP address check box.

Type the host name or IP address of the SMART Sync Class List Server
computer in the box below the check box.

NOTE

If your network uses DHCP, refer to the SMART Sync Class List Server
computer by host name rather than by IP address.

6. If the computer has multiple network adapters, click Network Adapter Selection
to specify the order of the network adapters.

7. Click Next.
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8. In theOptions page, clear theStart SMART Sync Student automatically check
box if you don’t want SMART Sync Student to start when the student first logs on.

NOTE

This check box is disabled if you selectedHidden from student in step 3.

9. Select the check boxes for the options you want to enable, and then click Next.

Check Box Select this check box to:
Ask questions Allow the student to ask questions through

SMART Sync.
Chat Allow the student to chat with other students

through SMART Sync.
Submit files Allow the student to submit files through SMART

Sync.
Exit the Student program Allow the student to close SMART Sync Student.

NOTE

These check boxes aren’t visible if you clickedHidden from student in
step 3.

10. In theStudent ID page, select one of the following options, and then click Next.

Option Select this option to:
Student Controlled Allow the student to enter an ID when

SMART Sync Student starts.

NOTE

This option is disabled if you selected
Hidden from student in step 3.

The following Enter a specific student ID.
Type the ID in the box to the right of the option.

Found in this Active
 Directory field…

Find the student ID in an Active Directory®
directory service field of the student’s login
account.
Type the field name in the box to the right of the
option.

Anonymous Allow the student to use SMART Sync Student
without entering an ID.
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11. In theShared Files Folder page, select one of the following options, and then click
Next.

Option Select this option to:
My Documents folder Store files the teacher shares with the student in

theMy Documents folder (Windows XP and
Windows 7) or theDocuments folder (Windows
Vista).

Custom folder Store files in another folder.
Type the path to the folder in the box below the
option.

12. In theSecurity page, select one of the following options, and then click Next.

Option Select this option to:
No security Allow any teacher with SMART Sync Teacher to

connect to the student.
Allow only teachers with
this class password

Allow only teachers who enter a specified
password in SMART Sync Teacher to connect to
the student.
Type the password in the two boxes to the right of
the option.

Allow only Teachers who
are part of the following
group(s)

Allow only teachers in certain groups to connect to
the student.
Select the groups in the box below the option.

13. Click Finish.

TheRestart Required to Apply Settings message appears.

14. Click OK.

Automatically Configuring SMARTSync Student
After you configure SMART Sync Student on one student’s computer using
SMART Sync Student Configuration Tool, copy theSyncClient.ini file from the
student’s computer to a central location on your network. (TheSyncClient.ini file is
located in%PROGRAMFILES%\SMART Technologies\SMART Sync Student.) You
can then copy the file to other students’ computers to configure SMART Sync Student
Configuration Tool automatically without running the tool each time.
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In a typical school- or district-wide installation, you deploy SMART Sync Teacher to all
teachers’ computers and SMART Sync Student to all students’ computers. As a system
administrator, you install SMART Sync Class List Server to connect teachers’ and
students’ computers and create a SMART School file with SMART Sync Administrator
Tool to centralize teacher, student and class information as well as application and
Internet blocking rules:

I MPORTANT

SMART Sync Class List Server and SMART Sync Administrator Tool are
beneficial tools for centrally managing teacher, student and class information
across a school or district.

Install SMART Sync Class List Server and SMART Sync Administrator Tool and
create a SMART School file before you install SMART Sync Teacher and
SMART Sync Student. This allows you to connect SMART Sync Teacher to the
SMART School file and SMART Sync Student to SMART Sync Class List
Server during installation rather than having to do somanually after installation.

Installing SMART Sync Class List Server
In a typical school- or district-wide installation, you install SMART Sync Class List
Server on a server or other computer on your school’s or district’s network that all
teachers’ and students’ computers can access.
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To install SMART Sync
Class List Server

from the CD

1. Insert the SMART Sync CD in the computer.

TheSMART Sync ClassroomManagement Software dialog box appears.

NOTE

If the dialog box doesn’t appear, browse to and open
[CD Drive]\CDBrowser.exe.

2. Click Install Teacher Edition.

The SMART Sync Teacher installation wizard appears.

3. Follow the on-screen instructions.

In the final step of the wizard, select the Install SMART Sync Class List Server
check box and clear the other two check boxes.

4. Click Install.

Windows Installer installs SMART Sync Class List Server.

To install SMART Sync
Class List Server
from the website

1. Go to www.smarttech.com/downloads.

2. Browse to the SMART Sync 2010 download page, and then follow the on-screen
instructions to download the SMART Sync Teacher executable file.

3. Double-click the executable file.

The SMART Sync Teacher installation wizard appears.

4. Follow the on-screen instructions.

In the final step of the wizard, select the Install SMART Sync Class List Server
check box and clear the other two check boxes.

5. Click Install.

Windows Installer installs SMART Sync Class List Server.

Installing and Using SMART Sync
Administrator Tool
SMART Sync Administrator Tool allows you to create SMART School files.
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A SMART School file contains information about students, teachers, classes and
computer labs in your school as well as rules that teachers can apply to block student
access to applications and websites. If you specify the location of a SMART School file
in SMART Sync Teacher, teachers can use this information to connect to their students.

In most situations, you only need to create one SMART School file per school so that all
teachers and students in the school can connect to each other. For security reasons,
when you create the file, save it in a location accessible to teachers and system
administrators, but not to students. After creating the file, you can update it.

Installing SMARTSync Administrator Tool
In a typical school- or district-wide installation, you install SMART Sync Administrator
Tool on one or more system administrators’ computers.

To install SMART Sync
Administrator Tool

from the CD

1. Insert the SMART Sync CD in the computer.

TheSMART Sync ClassroomManagement Software dialog box appears.

NOTE

If the dialog box doesn’t appear, browse to and open
[CD Drive]\CDBrowser.exe.

2. Click Install Teacher Edition.

The SMART Sync Teacher installation wizard appears.

3. Follow the on-screen instructions.

In the final step of the wizard, select the Install SMART Sync Administrator
Tool check box and clear the other two check boxes.

4. Click Install.

Windows Installer installs SMART Sync Administrator Tool.

To install SMART Sync
Administrator Tool
from the website

1. Go to www.smarttech.com/downloads.

2. Browse to the SMART Sync 2010 download page, and then follow the on-screen
instructions to download the SMART Sync Teacher executable file.

3. Double-click the executable file.

The SMART Sync Teacher installation wizard appears.
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4. Follow the on-screen instructions.

In the final step of the wizard, select the Install SMART Sync Administrator
Tool check box and clear the other two check boxes.

5. Click Install.

Windows Installer installs SMART Sync Administrator Tool.

Using Information from Third-Party Applications
If youmanage school information using a third-party application, youmay be able to
export the school information to a CSV (CommaSeparated Values) file to use it in your
SMART School file.

The information that the CSV file contains depends on how computers are used in your
school.

Creating a CSV File for Schools with Individual Computers
If each student has his or her own laptop or assigned computer in a class, you need to
create a CSV file that contains student, teacher and class information:

ID,Last Name,First Name,Title,Class ID,Class Title,Type

S001,Adams,John,,Eng,English,0

S002,Brook,Sally,,Eng,English,0

S003,Williams,Ronald,,Eng,English,0

T001,Johnson,Adam,Mr.,Eng,English,1

I MPORTANT

If a teacher or student is in multiple classes, the CSV file must contain multiple
lines for the teacher or student (one for each class).

To create a student,
teacher and class CSV file

1. Export student, teacher and class information from the third-party application to a
CSV file.

NOTE

See the third-party application’s Help for instructions.

2. Open the CSV file using Excel® or another application that can open CSV files.
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3. Ensure the CSV file contains the following columns:

Column Name Type Description
Person ID String The student’s or teacher’s unique ID.

I MPORTANT

The ID you enter heremust match
the ID the student uses to log on to
SMART Sync Student.

NOTE

The ID must be unique to the student
or teacher. For example, a student
and a teacher can’t both have the ID
123456.

Last Name String The student’s or teacher’s last name.
First Name String The student’s or teacher’s first name.
Title String The teacher’s title (for example,Mr.,Ms., or

Dr.).

NOTE

SMART Sync Administrator Tool
only stores this information for
teachers.

Class ID String The unique ID of the student’s or teacher’s
class.

Class Title String The name of the student’s or teacher’s
class.
If appropriate, include the class’s period to
distinguish it from other classes.

Type Integer 0 for a student.
OR
1 for a teacher.

NOTES

o The first row of the spreadsheet must contain the column names as
listed in the previous table.

o The string columns can contain any character except commas (,).

4. Save the CSV file.
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Creating a CSV File for Schools with Computer Labs
If computers are located in labs in your school, you need to create a CSV file that
contains computer lab information:

Hostname,Workstation Name,Lab ID,Lab Title

127.0.0.1,Main Lab WS1,Main,Main Lab

127.0.0.2,Main Lab WS2,Main,Main Lab

127.0.0.3,Main Lab WS3,Main,Main Lab

127.0.0.4,Main Lab WS4,Main,Main Lab

127.0.0.5,Main Lab WS5,Main,Main Lab

To create a computer lab
CSV file

1. Export computer lab information from the third-party application to a CSV file.

NOTE

See the third-party application’s Help for instructions.

2. Open the CSV file using Excel or another application that can open CSV files.

3. Ensure the CSV file contains the following columns:

Column Name Type Description
Hostname String The computer’s host name or IP address

(for example, 127.0.0.1).

NOTE

If your network uses DHCP, refer to
the computer by host name rather
than by IP address.

Workstation Name String The computer’s name.
Lab ID String The unique ID of the computer’s lab.
Lab Title String The name of the computer’s lab.

NOTES

o The first row of the spreadsheet must contain the column names as
listed in the previous table.

o The string columns can contain any character except commas (,).

4. Save the CSV file.
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Creating a SMARTSchool File
After installing SMART Sync Administrator Tool and exporting information from third-
party applications to CSV files, you can use SMART Sync Administrator Tool to create a
SMART School file.

Starting SMART Sync Administrator Tool
The first step in creating a SMART School file is to start SMART Sync Administrator
Tool.

To create a SMART School
file

1. Double-click theSMART Sync Administrator Tool 2010 icon on your desktop.

TheSMART Sync Administrator Tool window appears.

2. Click School File.

3. Click Create a new SMART School file and save it as.

4. Click Browse.

TheSelect School File Location dialog box appears.

5. Browse to the folder where you want to create the SMART School file.

I MPORTANT

For security reasons, create the SMART School file in a location that is
accessible to teachers and system administrators but not to students.
Teacher can have read-only access to the file, but system administrators
require read/write access.

6. Type a name in the File name box.

7. Click Save.

TheSelect School File Location dialog box closes, and the path to the SMART
School file appears in the box below theCreate a new SMART School file and
save it as option.

Locating SMART Sync Class List Server
Youmust enter the host name or IP address of the computer hosting SMART Sync
Class List Server in the SMART School file.
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To locate SMART Sync
Class List Server 1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator

Tool on previous page).

2. Click Class List Server.

3. Type the host name or IP address of the computer hosting SMART Sync Class
List Server in theEnter the IP address or hostname of your Class List Server box.

NOTES

o SMART Sync Class List Server uses port number 46200 by default.
However, you can change the port number. If you do so, youmust
include the port number after the host name or IP address (for
example, 127.0.0.1:46201).

o If your network uses DHCP, refer to the SMART Sync Class List
Server computer by host name rather than by IP address.

4. Click Test Connection to test the connection to the SMART Sync Class List
Server computer.

Importing School Information
You canmanually enter student, teacher and class or computer lab information in
SMART School files using SMART Sync Administrator Tool. Alternatively, you can
import this information from aCSV file generated from a third-party application (see
Using Information from Third-Party Applications on page 17).

To import student, teacher
and class information

1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator
Tool on previous page).

2. Click Import Information.

3. Click Browse to the right of theStudent, Teacher, Class CSV file Location box.

TheOpenClasses CSV File dialog box appears.

4. Navigate to and select a student, teacher and class CSV file.

5. Click Open.

TheOpenClasses CSV File dialog box closes, and the path to the CSV file
appears in theStudent, Teacher, Class CSV file Location box.
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To import computer lab
information 1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator

Tool on page 20).

2. Click Import Information.

3. Click Browse to the right of theComputer, Lab CSV File Location box.

TheOpen Labs CSV File dialog box appears.

4. Navigate to and select a computer lab CSV file.

5. Click Open.

TheOpen Labs CSV File dialog box closes, and the path to the CSV file appears
in theComputer, Lab CSV File Location box.

Entering Student Information
You can import student information from aCSV file (see Importing School Information on
previous page). Alternatively, you canmanually enter student information in a SMART
School file using SMART Sync Administrator Tool.

NOTE

Student information is required only if you’re entering classes in the SMART
School file (seeEntering Class or Computer Lab Information on next page).

To add a student 1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator
Tool on page 20).

2. Click Students.

3. Click Add Student.

A new row appears in the table.

4. Type the student’s last name in the Last Name column.

5. Type the student’s first name in the First Name column.
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6. Type the student’s ID in theStudent ID column.

I MPORTANT

The ID you enter heremust match the ID the student uses to log on to
SMART Sync Student.

NOTE

SMART Sync Administrator Tool generates a random ID for the student if
you don’t specify one.

Entering Teacher Information
You can import teacher information from aCSV file (see Importing School Information on
page 21). Alternatively, you canmanually enter teacher information in a SMART School
file using SMART Sync Administrator Tool.

NOTE

Teacher information is required only if you’re entering classes in the SMART
School file (seeEntering Class or Computer Lab Information below).

To add a teacher 1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator
Tool on page 20).

2. Click Teachers.

3. Click Add Teacher.

A new row appears in the table.

4. Type the teacher’s last name in the Last Name column.

5. Type the teacher’s first name in the First Name column.

6. Type the teacher’s title in the Title column (for example,Mr.,Ms. orDr.).

Entering Class or Computer Lab Information
If each student has his or her own laptop or assigned computer in a class, youmust enter
classes in the SMART School file.

OR

If computers are located in labs in your school, youmust enter the labs in the SMART
School file.
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You can import class or computer lab information from aCSV file (see Importing School
Information on page 21). Alternatively, you canmanually enter class or computer lab
information in a SMART School file using theClasses section orComputer Labs section
of SMART Sync Administrator Tool.

To add a class 1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator
Tool on page 20).

2. Click Classes.

3. Click Add.

A new row appears in the table.

4. Type a name in theClass Name column (for example, 5th Grade Math).

If appropriate, include the class’s period to distinguish it from other classes.

5. Select the name of a teacher or student you want to include in the class in the

All Students and Teachers list, and then click to move it to theClass
 Members list.

NOTES

o In theAll Students and Teachers andClass Members lists,
teachers’ names appear in red text and students’ names appear in
black text.

o To remove teachers or students from a class, select their names in

theClass Members list, and then click to move them to the
All Students and Teachers list.

6. Repeat step 5 for each teacher or student that you want to add to the class.

To add a computer lab 1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator
Tool on page 20).

2. Click Computer Labs.

3. Click Add.

A new row appears in the computer lab table.

4. Type a name in the Lab Name column (for example,Main Lab).

5. Click Add Computer.

A new row appears in the computer table.
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6. Type the host name or IP address of the computer in theHostname column (for
example, 127.0.0.1).

NOTE

If your network uses DHCP, refer to the computer by host name rather
than by IP address.

7. Type the name of the computer in theWorkstation Name column (for example,
Main Lab WS1).

8. Repeat steps 5 to 7 for each computer you want to add to the computer lab.

NOTE

To remove a computer from the computer lab, select the computer, and
then click Remove Computer.

Creating Administered Application Blocking Rules
An application blocking rule allows teachers either to allow specific applications and
block all others or to block specific applications and allow all others. For example, an
English teacher could allow access toMicrosoft® Word but block access to all other
applications during the writing of an English paper.

Teachers can individually create and share application blocking rules in SMART Sync
Teacher. Alternatively, you can create centrally administered application blocking rules
and include them in a SMART School file.
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To create a rule
1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator

Tool on page 20).

2. Click Application Blocking.

3. Click Add.

A new row appears in the application blocking rule table.

4. Type a name in theRule Name column (for example, English Paper).

5. Select Block all applications except those listed below to block all
applications except those you include in the rule.

OR

Select Allow all applications except those listed below to allow all
applications except those you include in the rule.

6. Click Add Application.

TheSelect Application dialog box appears.

7. Navigate to and select the application’s executable (.exe) file.

8. Click Open.

TheSelect Application dialog box closes, and a new row appears in the application
table.

9. Type a name for the application in theDisplay Name column if you don’t want to
use the default name.

10. Repeat steps 6 to 9 or each application you want to add to the application blocking
rule.

NOTE

To remove an application from the application blocking rule, select the
application, and then click Remove Application.

Creating Administered Internet Blocking Rules
An Internet blocking rule allows teachers either to allow specific websites and block all
others or to block specific websites and allow all others. For example, a history teacher
could block access to online encyclopedias and other history resources during the
writing of a history paper.
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Teachers can individually create and share Internet blocking rules in SMART Sync
Teacher. Alternatively, you can create centrally administered Internet blocking rules and
include them in a SMART School file.

To create a rule 1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator
Tool on page 20).

2. Click Internet Blocking.

3. Click Add.

A new row appears in the Internet blocking rule table.

4. Type a name in theRule Name column (for example, History Paper).

5. Select Block all websites except those listed below to block all websites
except those you include in the rule.

OR

Select Allow all websites except those listed below to allow all websites
except those you include in the rule.

6. Click Add Website.

A new row appears in the website table.

7. Type the address of the website in theWebsite Address column (for example,
www.example.com).

8. Repeat steps 6 to 7 for each website you want to add to the Internet blocking rule.

NOTE

To remove a website from the Internet blocking rule, select the website,
and then click Remove Website.

Reviewing the SMART School File
After creating a SMART School file, you can review it in theSummary section and then
close SMART Sync Administrator Tool to save the file. You should complete the
following tasks before reviewing and saving the file:

l Locate SMART Sync Class List Server (see Locating SMART Sync Class List
Server on page 20).
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l Import school information (see Importing School Information on page 21).

OR

Enter student, teacher or class information (seeEntering Student Information on
page 22, Entering Teacher Information on page 23, andEntering Class or
Computer Lab Information on page 23).

OR

Enter computer lab information (seeEntering Class or Computer Lab Information
on page 23).

l Create administered application blocking rules (seeCreating Administered
Application Blocking Rules on page 25).

l Create administered Internet blocking rules (seeCreating Administered Internet
Blocking Rules on page 26).

To review the SMART
School file

1. Start SMART Sync Administrator Tool (seeStarting SMART Sync Administrator
Tool on page 20).

2. Click Summary.

If any warnings appear, read them and take the appropriate actions.

3. Click Exit.

Installing SMART Sync Teacher and
SMART Sync Student
After installing SMART Sync Class List Server and SMART Sync Administrator Tool
and creating a SMART School file, you can install SMART Sync Teacher on teachers’
computers and SMART Sync Student on students’ computers.

Installing SMART Sync Teacher and SMART Sync Student across a school or district
involves three steps:

1. Locating the installation files

2. Customizing the installation packages

3. Deploying the installation packages
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Locating the Installation Files
The first step in installing SMART Sync Teacher and SMART Sync Student across a
school or district is to locate the installation packages and supporting files.

Locating the Installation Packages
There are two installation packages (also known as MSI files) for SMART Sync:

Installation
Package

File Name Components

SMART Sync
Teacher

SMART Sync
2010.msi

SMART Sync Teacher, SMART Sync
Class List Server and SMART Sync
Administrator Tool

SMART Sync
Student

SMART Sync
Student.msi

SMART Sync Student

Both installation packages are located on the SMART Sync CD. The SMART Sync
Teacher installation package is located in the TeacherSetup folder, and the SMART
Sync Student installation package is located in theStudentSetup folder.

Alternatively, you can download both packages from www.smarttech.com/downloads.

Save the packages in a location on your school’s network that is accessible to all
computers on which you plan to install SMART Sync.

| C H A PT ER 3 – I N ST AL L I N G SMAR T SYN C AC ROSS A SC HOOL OR

D I ST R I C T

http://www.smarttech.com/downloads


3 0

Locating the Language Files
If you plan to deploy the SMART Sync installation packages in a language other than
English (U.S.), ensure the correspondingMST file for that language is in the same folder
as theMSI file.

Language Code File
English (U.S.) 1033 1033.mst
English (UK) 2057 2057.mst
Arabic 1025 1025.mst
Chinese (Simplified) 2052 2052.mst
Czech 1029 1029.mst
Danish 1030 1030.mst
Dutch 1043 1043.mst
Finnish 1035 1035.mst
French 1036 1036.mst
German 1031 1031.mst
Greek 1032 1032.mst
Hungarian 1038 1038.mst
Italian 1040 1040.mst
Norwegian 1044 1044.mst
Polish 1045 1045.mst
Portuguese (Portugal) 2070 2070.mst
Portuguese (Brazil) 1046 1046.mst
Russian 1049 1049.mst
Spanish (Spain) 1034 1034.mst
Spanish (Mexico) 2058 2058.mst
Swedish 1053 1053.mst
Turkish 1055 1055.mst

TheMST files are available from the same locations as theMSI files.

Customizing the Installation Packages
After locating the installation packages, you can customize them by creatingMST files.
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I MPORTANT

If you installed SMART Sync Class List Server and SMART Sync Administrator
Tool and created a SMART School file, customize the SMART Sync Teacher
installation package to reference the SMART School file location and the SMART
Sync Student installation package to reference the SMART Sync Class List
Server location.

You can createMST files using SMART Install Manager (see page 53) or a third-party
tool such as Orca database editor and theWindows Installer properties (seeWindows
Installer Reference on page 45).

Deploying the Installation Packages
The final step in installing SMART Sync Teacher and SMART Sync Student is to deploy
the installation packages. You can do this using the command line interface, or third-
party imaging or remotemanagement software.

Using the Command Line Interface
Using the command line interface, you can deploy the SMART Sync Teacher and
SMART Sync Student installation packages inmany ways, including running commands
from the Command Prompt window and including commands in batch script files.

To install
SMART Sync Teacher

Run the following command if you created anMST file to customize the installation
package:

msiexec /i "[Path]\SMART Sync 2010.msi" TRANSFORMS="[MST

File]" [Parameter]

OR

Run the following command if you didn’t create anMST file to customize the installation
package:

msiexec /i "[Path]\SMART Sync 2010.msi" [Properties]

[Parameter]

Where

l [Path] is the path to theSMART Sync 2010.msi file andMST file.

l MST File is the name of theMST file.
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l Properties is a set of properties you can include to customize the installation (see
SMART Sync Teacher Installation Package on page 45).

I MPORTANT

If you installed SMART Sync Class List Server and SMART Sync
Administrator Tool and created a SMART School file, include the
SCHOOLFILE property.

l [Parameter] is the installation parameter (seeParameters on page 51).

To install
SMART Sync Student

Run the following command if you created anMST file to customize the installation
package:

msiexec /i "[Path]\SMART Sync Student.msi" TRANSFORMS="[MST

File]" [Parameter]

OR

Run the following command if you didn’t create anMST file to customize the installation
package:

msiexec /i "[Path]\SMART Sync Student.msi" [Properties]

[Parameter]

Where

l [Path] is the path to theSMART Sync 2010.msi file andMST file.

l MST File is the name of theMST file.

l Properties is a set of properties you can include to customize the installation (see
SMART Sync Teacher Installation Package on page 45).

I MPORTANT

If you installed SMART Sync Class List Server and SMART Sync
Administrator Tool and created a SMART School file, include the
SYNC_NAMINGSERVERLOC property.

l [Parameter] is the installation parameter (seeParameters on page 51).

Using Third-Party Imaging or Remote Management Software
The following procedure shows how to deploy SMART Sync usingWindows operating
systems’ Group Policy-based deployment software. For information on deploying
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SMART Sync using your organization’s third-party imaging or remotemanagement
software, see the software’s documentation.

NOTE

This proceduremay vary depending on your version of Windows operating
system and your system preferences.

To deploy an
installation package

1. Copy theMSI file and theMST file to \\[Domain Controller]\NETLOGON, where
[Domain Controller] is your school’s domain controller.

2. Open the Control Panel.

3. Double-click Administrative Tools.

4. Double-click Active Directory Users and Computers.

TheActive Directory Users and Computers window appears.

5. Right-click your school’s domain, and then select Properties.

TheProperties dialog box appears.

6. Click theGroup Policy tab, and then click Edit.

TheGroup Policy Object Editor dialog box appears.

7. Browse to and openComputer Configuration\Software Settings.

8. Right-click Software Installation, and then select New > Package.

9. Browse to and select theMSI file from step 1.

10. In theDeploy Software section, click Advanced, and then click OK.

11. Click theModifications tab, and then click Add.

12. Browse to and select theMST file from step 1.

13. Click OK to apply theMST file to theMSI file.

14. Close all open windows and dialog boxes.

The next time each computer on the domain starts, it automatically installs the
software in Silent mode with the customizations defined in theMST file.
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After installing SMART Sync, youmay need tomodify it or remove it. You can use the
same tools you used to install SMART Sync tomodify or remove it.

Using the Command Line Interface
Using the SMART Sync Teacher and SMART Sync Student installation packages (see
page 29), you can complete the following tasks using the command line interface:

l Adding or removing SMART Sync Teacher components

l Removing SMART Sync Teacher

l Removing SMART Sync Student

Adding or Removing SMARTSync Teacher Components
After installing the SMART Sync Teacher on a computer, youmay decide to add or
remove components. For example, youmay have installed SMART Sync Teacher on the
same computer you now want to install SMART Sync Class List Server and SMART
Sync Administrator Tool on.
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To add a component
Run the following command:

msiexec /i "[Path]\SMART Sync 2010.msi" [Remove properties]

/q

Where:

l [Path] is the path to theSMART Sync 2010.msi file.

l [Remove properties] is the set of properties for the component you want to
remove:

Components Add Properties
SMART Sync
Teacher

INSTALLTEACHER="" REINSTALLMODE=voums

REMOVE=Teacher

SMART Sync
Class List Server

INSTALLCLASSLISTSERVER=""

REINSTALLMODE=voums REMOVE=ClassListServer

SMART Sync
Administrator Tool

INSTALLADMINTOOL="" REINSTALLMODE=voums

REMOVE=AdminTool

See page 37 for examples.

To remove a component Run the following command:

msiexec /i "[Path]\SMART Sync 2010.msi" [Installation

properties] [Add properties] /q

Where:

l [Path] is the path to theSMART Sync 2010.msi file.

l [Installation properties] are the INSTALL properties of the components already
installed.

T I P

If SMART Sync Teacher is already installed, you don’t need to include the
INSTALLTEACHER property, as it’s enabled by default.
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l [Add properties] is the set of properties for the component you want to add:

Components Add Properties
SMART Sync
Teacher

INSTALLTEACHER="1" REINSTALLMODE=voums

ADDLOCAL=Teacher

SMART Sync
Class List Server

INSTALLCLASSLISTSERVER="1"

REINSTALLMODE=voums

ADDLOCAL=ClassListServer

SMART Sync
Administrator Tool

INSTALLADMINTOOL="1" REINSTALLMODE=voums

ADDLOCAL=AdminTool

See page 37 for examples.

Component Addition Examples
The following example installs SMART Sync Administrator Tool on a computer that
already has SMART Sync Teacher (but not SMART Sync Class List Server):

msiexec /i "D:\TeacherSetup\SMART Sync 2010.msi"

INSTALLADMINTOOL=1 REINSTALLMODE=voums ADDLOCAL=AdminTools

/qb

The following example installs SMART Sync Teacher on a computer that already has
SMART Sync Administrator Tool (but not SMART Sync Class List Server):

msiexec /i "D:\TeacherSetup\SMART Sync 2010.msi"

INSTALLADMINTOOL=1 INSTALLTEACHER=1 REINSTALLMODE=voums

ADDLOCAL=Teacher /qb

The following example installs SMART Sync Class List Server on a computer that
already has SMART Sync Teacher and SMART Sync Administrator Tool:

msiexec /i "D:\TeacherSetup\SMART Sync 2010.msi"

INSTALLADMINTOOL=1 INSTALLCLASSLISTSERVER=1

REINSTALLMODE=voums ADDLOCAL=ClassListServer /qb

Component Removal Examples
The following example removes SMART Sync Administrator Tool:

msiexec /i "D:\TeacherSetup\SMART Sync 2010.msi"

INSTALLADMINTOOL="" REINSTALLMODE=voums REMOVE=AdminTools /qb
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Removing SMARTSync Teacher and SMARTSync Student

To remove
SMART Sync Teacher Run the following command:

msiexec /x "[Path]\SMART Sync 2010.msi" /q

To remove
SMART Sync Student

Run the following command:

msiexec /x "[Path]\SMART Sync Student.msi" /q

Using Third-Party Imaging or Remote
Management Software
The following procedure shows how to remove SMART Sync usingWindows operating
systems’ Group Policy-based deployment software. For information on removing
software using your organization’s third-party imaging or remotemanagement software,
see the software’s documentation.

NOTE

This proceduremay vary depending on your version of Windows operating
system and your system preferences.

To remove a deployed
installation package

1. Open the Control Panel.

2. Double-click Administrative Tools.

3. Double-click Active Directory Users and Computers.

TheActive Directory Users and Computers window appears.

4. Right-click your school’s domain, and then select Properties.

TheProperties dialog box appears.

5. Click theGroup Policy tab, and then click Edit.

TheGroup Policy Object Editor dialog box appears.

6. Browse to and openComputer Configuration\Software Settings\
Software Installation.
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7. Right-click the software you want to remove, and then select All Tasks >
Remove.

8. Select Immediately uninstall the software from users and computers, and
then click OK.

The next time each computer on the domain starts, it automatically removes the
software.
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Before installing SMART Sync, configure your computers and network as documented in
this appendix for optimal performance.

Display Settings
SMART Sync works best when the teachers’ and students’ computers are set to the
same screen resolution and color depth. However, the softwaremakes adjustments for
different color settings and resolutions. For example, if a broadcasting computer (either
teacher or student) runs at a higher resolution than a viewing computer, scroll bars
appear on the viewing computer so you can view the entire higher-resolution screen.

Similarly, if a broadcasting computer has a higher color setting than a viewing computer,
the broadcasting computer’s colors are reduced so the user can see it at the viewing
computer. For example, if a student’s computer has a higher color setting than the
teacher’s computer, the teacher sees aColor Reducedmessage below the thumbnail.
When the teacher views a live, full-screen image, the colors appear slightly degraded.

For information on how to change the display settings of your school’s monitors, see the
instructions that camewith the operating system.
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SMART Sync works best when the screen resolution is 1024 × 768. Refer to the
following table for the optimal screen resolution and color depth for your school’s
monitors.

Color Depth/Screen Resolution High Color (16-bit) True Color (32-bit)
1024 × 768 or lower Optimal Optimal
1152 × 864 Acceptable Acceptable
1280 × 1024 Acceptable Acceptable
1600 × 1200 Acceptable Not recommended

Network Size and Speed
The preferred TCP/IP network configuration for SMART Sync is a switch or a switching
hub that restricts network traffic to a particular segment of your local area network. In
this configuration, other network traffic doesn’t affect your system and SMART Sync
doesn’t slow down other segments of the network. Network activity is faster when the
number of connected students is smaller.

Network Type Maximum Number
of Students

100Mbps 80
Wireless (single 802.11 a/g access point) 30
Wireless (single 802.11 n access point) 35

T I P

Graphics-rich backgrounds on your students’ screens may slow SMART Sync’s
performance. Performance is best if your students’ screens have simple,
single-color backgrounds.

Internet Connection Firewalls
If you install SMART Sync on a computer that has an active Internet connection firewall,
the firewall can cause network problems. If possible, set the firewall to allow network
traffic from SMART Sync. If this doesn’t resolve the problem, ensure the following
network communication ports are open:

Port Type Purpose
5463 TCP Main teacher to student communications port
5485 TCP Main teacher to teacher communications port
5496 UDP Teacher discovery port
5491 UDP Broadcast port
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Port Type Purpose
5493 UDP Broadcast recovery port
46200 TCP SMART Sync Class List Server
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Windows Installer Reference
Properties 45

SMART Sync Teacher Installation Package 45
SMART Sync Student Installation Package 47

Parameters 51

The SMART Sync installation packages contain all of the information that Windows
Installer requires to install or remove the SMART Sync components. Run theMSI files
from a command prompt to start Windows Installer and install or modify the software
using available properties and parameters.

Properties

SMARTSync Teacher Installation Package
The following are properties for the SMART Sync Teacher installation package:

Property Values Notes
General Properties
INSTALLDIR [String]: The path to your

preferred folder for SMART Sync
Teacher.

If you don’t include this property,
Windows Installer installs
SMART Sync Teacher in
%PROGRAMFILES%\
SMART Technologies\
SMART Sync 2010.

ISX_
SERIALNUM

[String]: The 22-character
product key you received from
SMART.

Appendix B



4 6

Property Values Notes
TRANSFORMS [String]: A languageMST file for

the installation (see Locating the
Language Files on page 30).

Ensure the specifiedMST file is
in the same folder as theMSI
file.
This property defines the
language of the installer’s user
interface and the installed
software’s icons and shortcuts.
It doesn’t define the installed
software’s user interface
language. The installed software
uses the computer’s operating
system language if it’s
supported, or English (U.S.) if
not.

SMART Sync Teacher Properties

INSTALL
TEACHER

1 (default): Install SMART Sync
Teacher.
[Null]: Don’t install SMART
Sync Teacher.

INSTALL
CLASSLIST
SERVER

1: Install SMART Sync Class
List Server.
[Null] (default): Don’t install
SMART Sync Class List Server.

INSTALL
ADMINTOOL

1: Install SMART Sync
Administrator Tool.
[Null] (default): Don’t install
SMART Sync Administrator
Tool.

SCHOOLFILE [String]: The path to the SMART
School file.

Before you can specify the path
to a SMART School file, you
must install SMART Sync
Administrator Tool, and then use
it to create the SMART School
file.

SMART Product Update Properties
INSTALL_SPU 1: Install SMART Product

Update.
[Null] (default): Don’t install
SMART Product Update.

SMART Product Update doesn’t
check for updates to SMART
Sync. However, it does check
for updates to other installed
SMART products.
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Property Values Notes

SPU_TIME_
FRAME

[Integer]: The time in days
between SMART Product
Update checks.

By default, SMART Product
Update checks for product
updates every 30 days. You can
set it to check for product
updates at intervals of one to 60
days.
This property is only applicable if
you install SMART Product
Update.

PRODUCT_
NOTIFICATION

1 (default): Notify the user when
updates are available from
SMART Product Update.
[Null]: Don’t notify the user when
updates are available from
SMART Product Update.

This property is only applicable if
you install SMART Product
Update.

SMARTSync Student Installation Package
The following are properties for the SMART Sync Student installation package:

Property Values Notes
General Properties
INSTALLDIR [String]: The path to your

preferred folder for SMART Sync
Student.

If you don’t include this property,
Windows Installer installs
SMART Sync Student in
%PROGRAMFILES%\
SMART Technologies\
SMART Sync Student.

TRANSFORMS [String]: A languageMST file for
the installation (see Locating the
Language Files on page 30).

Ensure the specifiedMST file is
in the same folder as theMSI
file.
This property defines the
language of the installer’s user
interface and the installed
software’s icons and shortcuts.
It doesn’t define the installed
software’s user interface
language. The installed software
uses the computer’s operating
system language if it’s
supported, or English (U.S.) if
not.
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Property Values Notes
LOCALE [Integer]: A language code for

SMART Sync Student (see
Locating the Language Files on
page 30).

If you don’t specify a language
code using LOCALE, SMART
Sync Student uses the
computer’s operating system
language if it’s supported, or
English (U.S.) if not.

SMART Sync Student Properties
CREATE_
SHORTCUTS

1 (default): Include shortcuts to
SMART Sync Student in the
Start menu and on the desktop.
[Null]: Don’t include shortcuts to
SMART Sync Student in the
Start menu and on the desktop.

PATHTOINI [String]: The full path and file
name for theSyncClient.ini file.

If you’ve previously installed
SMART Sync Student, you can
run the SMART Sync Student
Configuration Tool to create a
SyncClient.ini file, which you
can then refer to in this property.
If you don’t include this property,
you can configure SMART Sync
Student using theSYNC_*
properties described below.
If you don’t include this property
or theSYNC_* properties,
Windows Installer refers to the
SyncClient.ini file in the same
folder as theMSI file. If
Windows Installer can’t find a
SyncClient.ini file in this folder,
it uses a default SyncClient.ini
file.

SYNC_VISIBLE 1 (default): Show the SMART
Sync Student user interface.
0: Hide the SMART Sync
Student user interface.

SYNC_
CONTEACHID

[String]: A teacher ID to which
SMART Sync Student will
connect automatically.

If you set SYNC_VISIBLE to 0,
youmust include this property,
SYNC_CONNECTIP orSYNC_
NAMINGSERVERLOC.
If you include this property, don’t
includeSYNC_CONNECTIP
andSYNC_
NAMINGSERVERLOC.
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Property Values Notes
SYNC_
CONNECTIP

[String]: A teacher host name or
IP address to which SMART
Sync Student will connect
automatically.

If you set SYNC_VISIBLE to 0,
youmust include this property,
SYNC_CONTEACHID or
SYNC_
NAMINGSERVERLOC.
If you include this property, don’t
include SYNC_CONTEACHID
andSYNC_
NAMINGSERVERLOC.

SYNC_NAMING
SERVERLOC

[String]: A SMART Sync Class
List Server host name or IP
address to which SMART Sync
Student will connect
automatically.

If you set SYNC_VISIBLE to 0,
youmust include this property,
SYNC_CONTEACHID or
SYNC_CONNECTIP.
If you include this property, don’t
include SYNC_CONTEACHID
andSYNC_CONNECTIP.

SYNC_
AUTOSTART

1 (default): Start SMART Sync
Student when the student first
logs on.
0: Don’t start SMART Sync
Student when the student first
logs on.

This property is only applicable if
you set SYNC_VISIBLE to 1.

SYNC_ENABLE
QUESTIONS

1 (default): Allow the student to
ask questions through SMART
Sync Student.
0: Don’t allow the student to ask
questions through SMART Sync
Student.

This property is only applicable if
you set SYNC_VISIBLE to 1.

SYNC_
ENABLECHAT

1 (default): Allow the student to
chat with other students through
SMART Sync Student.
0: Don’t allow the student to chat
with other students through
SMART Sync Student.

This property is only applicable if
you set SYNC_VISIBLE to 1.

SYNC_
ENABLEFILE
TRANSFER

1 (default): Allow the student to
submit files through SMART
Sync Student.
0: Don’t allow the student to
submit files through SMART
Sync Student.

This property is only applicable if
you set SYNC_VISIBLE to 1.

SYNC_
DISPLAYEXIT

1: Allow the student to close
SMART Sync Student.
0: Don’t allow the student to
close SMART Sync Student.

This property is only applicable if
you set SYNC_VISIBLE to 1.
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Property Values Notes
SYNC_
STUDIDMODE

0: Use a student ID found in an
Active Directory field specified in
SYNC_ACTDIRSTUDID.
1: Use a student ID specified in
SYNC_STUDENTID.
2: Allow the student to enter an
ID when SMART Sync Student
starts.
3: Allow the student to use
SMART Sync Student without
entering an ID.

If you set SYNC_VISIBLE to 1,
this property’s default value is 2.
If you set SYNC_VISIBLE to 0,
this property’s default value is 1.
In this situation, youmust
includeSYNC_STUDENTID.

SYNC_
ACTDIRSTUDID

[String]: The name or ID of an
Activity Directory field that
contains the student’s ID.

If you include this property,
SYNC_STUDIDMODE is set to
0 automatically.

SYNC_
STUDENTID

[String]: A student ID. If you include this property,
SYNC_STUDIDMODE is set to
1 automatically.

SYNC_
CUSTSHRD
FOLDER

[Null] (default): Store files the
teacher shares with the student
in theMy Documents folder
(Windows XP andWindows 7) or
Documents folder (Windows
Vista).
[String]: Store files the teacher
shares with the student in
another folder specified in this
property.
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Parameters
The following are the standardWindows Installer parameters:

Parameter Use
/q Hide the installation wizard.

NOTE

This is Silent mode.

/qb Show a basic installation wizard.
/qb! Show a basic installation wizard without aCancel button.
/qb+ Show a basic installation wizard with a dialog box signaling the end of

the installation.
/qb+! Show a basic installation wizard without aCancel button but with a

dialog box signaling the end of the installation.
/qr Show a reduced installation wizard.
/qf Show the full installation wizard, including a dialog box signaling the

end of the installation or the Fatal Error, User Exit orExit dialog box.
/qn Hide the installation wizard and the dialog box signaling the end of the

installation.
/qn+ Hide the installation wizard but show the dialog box signaling the end

of the installation.
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Opening an Installation Package 54
Saving Your Changes 55
Publishing Your Changes as anMST File 55

Customizing the SMART Sync Teacher Installation Package 56
Customizing the SMART Sync Student Installation Package 57

SMART Install Manager allows you to customize SMART software installation
packages (also known as MSI files) by publishingMST files. You can then install the
MSI andMST files on computers using third-party imaging or remotemanagement
software.

Installing SMART Install Manager
You can install SMART Install Manager from the included CD.

OR

You can download and install SMART Install Manager from the SMART Support
website.

To install the software
from the CD

1. Insert the CD in your computer’s CD drive. A dialog box appears.

NOTE

If the dialog box doesn’t appear, browse to and open
[CD Drive]\CDBrowser.exe inWindows Explorer.

2. Click Administrator Preparation and Tools, and then click Install SMART
Install Manager.

TheSMART Install Manager installation wizard appears.
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3. Follow the on-screen instructions.

4. Click Install.

Windows Installer installs SMART Install Manager.

To install the software
from the website

1. Go to www.smarttech.com/downloads.

2. Browse to the appropriate download page, and then follow the on-screen
instructions to download the Install Manager.exe executable file.

3. Double-click the Install Manager.exe file.

TheSMART Install Manager installation wizard appears.

4. Follow the on-screen instructions.

5. Click Install.

Windows Installer installs SMART Install Manager.

Using SMART Install Manager
After you install SMART Install Manager, shortcuts to the software appear on the
desktop and in the Start menu underAll Programs > SMART Technologies >
SMART Install Manager.

With SMART Install Manager, you can do the following:

l Open an installation package.

l Save your changes to the installation package.

l Publish your changes to the installation packages as anMST file.

Opening an Installation Package
To customize an installation package, open its MSI file in SMART Install Manager by
doing one of the following:

l Select File > Open.

l Click .

l Click and drag theMSI file into theSMART Install Managerwindow.

Alternatively, you can search for installation packages on your computer by clicking ,
or on CDs or DVDs by clicking .
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T I P

All installation packages you’ve previously opened in SMART Install Manager
appear in theUnmodified Packages tab.

After you open an installation package, a set of pages for that installation package
appear in SMART Install Manager:

Customize the installation package using the controls in these pages.

Saving Your Changes
After customizing an installation package, you can save your changes as an XML file by
selecting File > Save As. When you next start SMART Install Manager, you can load
the XML file by selecting File > Open, or by opening theMSI file, and then selecting
File > Import.

T I P

All XML files you create or open in SMART Install Manager appear in theModified
Packages tab of theWelcome page.

Publishing Your Changes as anMST File
The final step in using SMART Install Manager to customize an installation package is to
publish your changes as anMST file. Do this by selecting File > Publish, and then
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using the dialog box to define a location for and create theMST file.

T I P

Publish theMST file in the same network location as theMSI file.

Customizing the SMART Sync Teacher
Installation Package
To customize the SMART Sync Teacher installation package, open theSMART Sync
2010.msi file in SMART Install Manager (seeUsing SMART Install Manager on page
54), and then complete the following procedures.

To set installation options 1. Click Installation Options.

The Installation Options page appears.

2. In the Installation directory box, type the path to your preferred folder for
SMART Sync.

NOTE

If you don’t include this property, Windows Installer installs SMART Sync
Teacher in%PROGRAMFILES%\SMART Technologies\SMART Sync
2010.

3. Select the check boxes of the software components you want to install.

4. Click Product Key.

TheProduct Key page appears.

5. In theProduct key box, type your school’s 22-character product key for SMART
Sync.

To configure SMART
 Product Update

1. Click SMART Product Update (SPU) Options.

TheSMART Product Update (SPU) Options page appears.
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2. Select the Install SMART Product Update check box to install SMART Product
Update.

NOTE

SMART Product Update doesn’t check for updates to SMART Sync.
However, it does check for updates to other installed SMART products.

3. In theCheck for updates box, type the number of days between SMART Product
Update checks.

NOTE

By default, SMART Product Update checks for product updates every 30
days. You can set it to check for product updates at intervals of one to 60
days.

4. Select theNotify users about SMART product updates check box to notify the
user when product updates are available.

To specify a SMART
 School file

1. Click SMART School File.

TheSMART School File page appears.

2. In theSMART School file box, type the path to the SMART School file.

OR

Click Browse, and then use the dialog box to browse to and select the SMART
School file.

NOTE

Before you can specify the path to a SMART School file, youmust install
SMART Sync Administrator Tool, and then use it to create the SMART
School file.

Customizing the SMART Sync Student
Installation Package
To customize the SMART Sync Student installation package, open theSMART Sync
Student.msi file in SMART Install Manager (seeUsing SMART Install Manager on page
54), and then complete the following procedures.
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When customizing the SMART Sync Student installation package, you can configure
the software by using either aSyncClient.ini file or the controls in SMART Install
Manager.

To set installation options 1. Click Installation Options.

The Installation Options page appears.

2. In the Installation directory box, type the path to your preferred folder for
SMART Sync.

NOTE

If you don’t include this property, Windows Installer installs SMART Sync
Student in%PROGRAMFILES%\SMART Technologies\SMART Sync
Student.

3. Select the Install Start menu and desktop shortcuts check box to create
shortcuts to SMART Sync in the Start menu and on the desktop.

To configure SMART Sync
Student using a

SyncClient.ini File

1. Click Student Configuration File.

TheStudent Configuration File page appears.

2. In theConfiguration file box, type the full path and file name for theSyncClient.ini
file.

OR

Click Browse, and then use the dialog box to browse to and select the
SyncClient.ini file.

NOTE

If you’ve previously installed SMART Sync, you can run the SMART Sync
Student Configuration Tool to create aSyncClient.ini file, which you can
then refer to in this box.

To configure SMART Sync
Student using SMART

Install Manager

1. Click Interface.

The Interface page appears.

| A PPEN D I X C – SMAR T I N ST AL L MAN AGER R EF ER EN C E



5 9

2. Select one of the following options:

Option Select this option to:
Visible to students Show the SMART Sync user interface to the

student.
Hidden from students Hide the SMART Sync user interface from the

student.

NOTE

If you click Hidden from students, the student won’t be able to do the
following:

o Connect to a teacher by selecting his or her name from a list

o Manually start SMART Sync Student

o Manually enter an ID after starting SMART Sync Student

3. Click Startup.

TheStartup page appears.
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4. Select one of the following options:

Option Select this option to:
Allows the student to
select from a list of
available teachers

Allow the student to select a teacher from a list.

NOTE

This option is disabled if you clicked
Hidden from student in step 2.

Automatically connects
with this Teacher ID

Connect SMART Sync to a specific teacher
through the teacher’s ID.
Type the ID in the box to the right of the option.

Automatically connects
with this hostname or IP
address

Connect SMART Sync to a specific teacher
through the host name or IP address.
Type the host name or IP address in the box below
the option.

NOTE

If your network uses DHCP, refer to the
computer by host name rather than by IP
 address.

Uses this Class List
Server hostname or IP
address

Connect SMART Sync to a specific teacher using
SMART Sync Class List Server.
Type the host name or IP address of the SMART
Sync Class List Server computer in the box below
the option.

NOTE

If your network uses DHCP, refer to the
SMART Sync Class List Server computer
by host name rather than by IP address.

I MPORTANT

If you clickedHidden from student in step 2 but do not provide a teacher
ID, host name or IP address in this step, the student will not be able to
connect to a teacher.

5. Click Options.

TheOptions page appears.

6. Clear theStart SMART Sync automatically check box if you do not want
SMART Sync Student to start when the student first logs on.

NOTE

This check box is disabled if you selectedHidden from student in step 2.
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7. Select the following check boxes:

Check Box Select this check box to:
Ask questions Allow the student to ask questions through SMART

Sync Student.
Chat Allow the student to chat with other students

through SMART Sync Student.
Submit files Allow the student to submit files through SMART

Sync Student.
Exit the Student program Allow the student to close SMART Sync Student.

NOTE

These check boxes aren’t visible if you clickedHidden from student in
step 2.

8. Click Student ID.

TheStudent ID page appears.

9. Select one of the following options:

Option Select this option to:
Student Controlled Allow the student to enter an ID when SMART

Sync Student starts.

NOTE

This option is disabled if you clicked
Hidden from student in step 2.

The following Enter a specific student ID.
Type the ID in the box to the right of the option.

Found in this Active
Directory field…

Find the student ID in an Active Directory field of
the student’s login account.
Type the Active Directory field name in the box to
the right of the option.

Anonymous Allow the student to use SMART Sync Student
without entering an ID.

10. Click Shared Files Folder.

TheShared Files Folder page appears.
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11. Select one of the following options:

Option Select this option to:
My Documents folder Store files the teacher shares with the student in

theMy Documents folder (Windows XP or
Windows 7) orDocuments folder (Windows Vista).

Custom folder Store files in another folder.
Type the path to the folder in the box below the
option.
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Customer Support

Online Information and Support
Visit www.smarttech.com/support to view and download user’s guides, how-to and
troubleshooting articles, software andmore.

Training
Visit www.smarttech.com/trainingcenter for trainingmaterials and information about our
training services.

Technical Support
If you experience difficulty with your SMART product, please contact your local reseller
before contacting SMART Support. Your local reseller can resolvemost issues without
delay.

NOTE

To locate your local reseller, visit www.smarttech.com/where.

All SMART products include online, telephone, fax and e-mail support:

Online www.smarttech.com/contactsupport

Telephone +1.403.228.5940 or
Toll Free 1.866.518.6791 (U.S./Canada)
(Monday to Friday, 5 a.m. – 6 p.m. Mountain Time)

Fax +1.403.806.1256

E-mail support@smarttech.com

Appendix D
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General Inquires
Address SMART Technologies

3636 Research Road NW
Calgary, AB T2L 1Y1
CANADA

Switchboard +1.403.228.5940 or
Toll Free 1.866.518.6791 (U.S./Canada)

Fax +1.403.228.2500

E-mail info@smarttech.com

Registration
To help us serve you, register online at www.smarttech.com/registration.
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